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Introduction
In order to make Safran as smooth and efficient as possible in use, a comprehensive set
of both powerful and intelligent filtering capabilities are available throughout the system.

By applying filters, you can dive into details, single out groups of activities or specific
activities of interest or concern in order to present a focused picture. Reports are of far
less use if the information and issues are buried on page 24 and 27 of a 56-page report.
It’s a good practice to set a laser focus on the issue, turning data into information to get
the attention of stakeholders, planners, discipline leads, project managers and others.
In addition to the obvious use of filters for selecting activities or resources, filters are also
used when specifying both conditional formatting of rows, cells, columns, text, fonts and
symbol definitions in the Barchart Editor, as well as when executing global updates with
Assign Fields.

Global filtering capabilities are also available to users who often or always work with the
same subset of activities within a project no matter which tool within Safran they are
using be it the Barchart Editor, Reporting Suite or Assign Fields.

Filtering capabilities are also provided for limiting the list of Barchart layouts, Histogram
configurations, and Filter definitions as well as being used for locating Projects in your
database.

This document provides both an overview and details on filtering capabilities, how to
establish and store filters for reuse, as well as how to use the auto filtering capabilities of
the Barchart Editor. The intention of this document is to collect and present the filtering
capabilities of different functions, features and options throughout Safran Project.
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Filters - General Concepts
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Activity filters are considered to be ‘Global’ within Safran in that, once a filter is
established, stored and named, it is immediately available for use in all the relevant tools
and functions throughout Safran. 

Furthermore, stored filters are available to all users within the database. Typically, you can
use, and even temporarily modify, a filter defined and stored by another user, however
you will not be allowed to save any changes to the original filter. 

If you want to keep the filter for later use, you can give it a name and save it as one of your
own.

If you set up a filter without giving it a name and storing it, the filter will still be associated
and applied on the Layout or Report it was established with but not generally available
elsewhere.
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Activity Filters
Activity filters are used to select one or more activities and can be based on almost any
activity property and all user defined data. 

Examples of activity properties are Duration, Calendar, Activity ID, Free Float, Total Float,
Dates, Codes, Scopes, or Planned QTY. 

User Fields come in different categories. Reference Fields and Outline Codes are typically
used to store codes such as Project Phase, Discipline, Product or similar. The other User
Field types Text, Date, Decimal, Flag and Computed Fields can also be used in a filter.

Any number of selection criteria may be established on any number of fields. 

Filters also support comparative capabilities allowing you to compare values from two
different fields. 

A typical example of such would be a filter containing the expression ‘Actual % < Baseline
Planned Progress’ which would present activities lagging behind schedule.  Another
example would be activities with ‘Current Early Finish> Baseline Early Finish’, comparing
information in two date fields.

In short, filters in Safran provide you with a powerful tool allowing you to drill down and
focus your, or your manager’s, attention on details/areas of interest or concern.
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The Filter Window - Defining a Filter - The Basics
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Even though Filters are available in all functional areas of Safran, they are most easily
found by selecting Filters on the Home tab of the ribbon when using the Barchart Editor. 
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Figure 1: Press the Filters icon to open the Filter window. The filter window allows you to define your selection
criteria.

The filter window will then appear providing you with a number of functions in addition to
defining the filter or selection criteria itself such as finding an existing filter, limiting the list
of filters, creating a new filter or save the filter expression, rename the filter and delete any
unused filters as part of your housekeeping. 

Figure 2: The Standard Filters window that allows to add criteria, modify, save the definitions for re-use,
rename, and delete unused or superfluous filters as part of your housekeeping and system maintenance.

The buttons at the top allow you to create a new filter, save current configuration to a
new name using the Save AS, Rename and Delete a filter.

The buttons at the bottom of the filter window allow you to add, delete or manipulate the
order of your filter elements. The Apply button will execute the filter in the current tool you
are using without closing the filter window. This allows you to see the effect of the filter
and easily make modifications to it if needed to get the correct results. By pressing the OK
button, the filter is executed, the conditions saved and the filter window is closed. 



To start defining a filter, press the Add Row button to open a new row and drop into the
Field area to select a relevant field to filter on. Then, drop into the Operator area and
select a relevant operator. Finally, enter a valid Expression. 

In the example below ‘Actual % < 100’ would select all incomplete activities.
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Figure 3: Create your filter by adding or inserting rows and select fields, operator and expression. A filter can
be one line or contain multiple criteria on multiple lines.

If you are satisfied with the filter properties and the resulting selection, press the Save As
button, enter a name for the filter and press the OK button to save the filter.

Figure 4: Save your filter criteria and give it a name. Retrieving saved filters will save you from the work of
having to re-enter filters that you use throughout your project. Saving and naming filters builds a library to
choose from.
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Once the filter is saved, it can be retrieved for use throughout Safran as shown in the
examples below:

Figure 5: Example from the Barchart Editor showing how previously saved filter expressions may be selected
from the drop-down list.

Figure 6: Example from the Histogram/S-curve report, where filters may be selected from the drop down on the
Filters tab.
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Figure 7: Example showing how filters can be selected from the Assign Fields (global change) window.
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Figure 8: A filter comparing two fields, Actual % less than Baseline Planned Progress.

Simple Filters
In addition to being able to check a value for a specific field, a filter may also compare
values from two different fields. As an example, a filter could contain the condition ‘Actual
% < Baseline Planned Progress’ which would select activities that are behind schedule or
‘Current Early Finish > Baseline Early Finish’ which would select activities that currently will
be delayed.
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Figure 9: Safran allows you to build highly complex criteria with multiple lines combined with AND OR
operators and grouped by parathesis. It may take some training to set up these criteria.

Complex Filters - Introducing Operators
In real life filters tend to be much more complex than those shown in the first examples.
Typically, a filter consists of multiple rows and conditions or even multiple groups of
conditions as the example shown below illustrates:

AND OR Operators
When combining multiple conditions, the Boolean operators AND and OR are used. These
are probably the most important operators when building complex filters as they provide
an immense amount of power and flexibility. Knowing how to use Boolean operators
effectively is essential as it can save you a lot of time in finding the right subset of
activities and resources for your analysis or report.

Using ‘AND’ between two or more conditions will select information where both or all
conditions are met. 
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Figure 10: The And operator returns true only if both lines are TRUE.

Using ‘OR’ between two or more conditions will select information where at least one of
the conditions is met.

Figure 11: The Or operator returns TRUE if one of the criteria is TRUE.
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Figure 12: Use parentheses to group criteria. Safran starts with the lowest/innermost level when checking for
TRUE or FALSE and returning values.

Using Parantheses to Combine Expressions
Parentheses allow you to group together conditions and control the order in which the
terms will be considered, just like in a mathematical statement. Conditions and Boolean
operators within parentheses will be considered first, followed by conditions outside
parentheses or subsequent groups of conditions. 

Typically, you will often need to use parentheses when you establish a filter including a
combination of ‘And’ and ‘Or’ binary operators.

When establishing highly complex filters consisting of multiple groups of conditions or
even multiple levels of conditions or groups within groups parentheses are often required.
You’ll also notice that you can have up to 3 levels or parentheses in your filter.

When resolving filters with multiple conditions without parentheses, Safran will examine
each condition or row sequentially from top to bottom in order to select information.

If a filter contains one or more sets of parentheses (i.e. a left-hand and right-hand
parentheses) with multiple levels Safran will start with the with the lowest level or
innermost condition and work itself logically to the highest or outermost level.

Working with complex filters may often be quite challenging or intimidating as you try to
build a filter that may make sense in your own mind while not giving the right result or
even producing an error message. Our advice is to take a step back and a deep breath
and re-analyze/mentally run through your filter group for group, condition for condition in
order to find it’s short coming or logical weakness.



Operator Means

= Equal to

> Greater than

< Less than

<= Less than or equal to

>= Greater than or equal to

<> Different than, does not equal
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Simple Operators (=, >, <)
The most common operators are more or less self-explanatory and consist of =, >, and <
in addition to combinations of two of the common operators. 

For DATE and DATETIME fields, less than and greater than means ‘earlier and later in time’.

For character or text type fields, less than and greater than means before and after in the
ASCII code-set order, i.e. where symbols such as %, (, and ! are lowest, followed by
numerals 1, 5, 8 and finally letters A, B, C, a, b, c. Keep in mind that capitol letters are
considered lower than lower case letters. Please refer to ascii-code.com for more
information on the ASCII code table. 

The simple operators listed above are available for almost all of the fields in Safran.

IS NULL and IS NOT NULL Operators
A Field with a NULL value is a field with no value. Nothing has been entered. Not from
system defaults nor from the user. Keep in mind that there is a distinct difference
between 0 and Null as 0 (‘Zero’) is considered a value while Null means No value or
empty. 

The absence of values is tested with the IS NULL Operator. For example, ‘Cancelled Date IS
NULL’.

The IS NOT NULL operator is used to test for presence of values, without expressing a
specific value. 

It is not relevant to use comparison operators such as =,<,>, or <> to test for NULL values.

https://www.ascii-code.com/


Operator Means

IS NULL No value present (empty)

IS NOT NULL A value is present
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The above is true for Reference fields and Outline Codes due to the fact that the ‘code’
portion of field is in natural fact always a ‘text’ value.

Text and Code Operators Begins, Contains, Ends
Some field types may also have additional operators and properties. 

In addition to simple operators, Text fields and Reference fields as well as Outline Code
levels also have the additional operators listed below:

Operator Means

Begins Field or Code begins with ‘text’

Ends Field or Code ends with ‘text’

Contains Field or Code contains ‘text’

Not Begins Field or Code does not begin with ‘text’

Not Ends Field or Code does not end with ‘text’

Not Contains Field or Code does not contain ‘text’

IN and NOT IN Operators
Reference fields and Outline Codes also have the additional operators IN and Not IN. 

Using the IN operator is a way of simplifying a filter when selecting activities based on
multiple values for a given field.

The filter ‘Discipline=E or Discipline=I or Discipline=T’ could be expressed ‘Discipline IN E, I,
T’ which would have the same effect. 



Operator Means

In Value exists in list

Not in Value does not exist in list
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Note that to use IN and NOT IN you must use the code from the Reference Field or
Outline Code and separate the values with a comma.

Similarly, the operator Not IN could be used to exclude certain activities based on
Reference or Outline field values, i.e. ‘I want to see all activities except those belonging
to one or more specific Disciplines’.

Figure 13: This filter consists of 4 lines with the = operator and the OR operator to select activities from 4
Products (stored in the reference fields).
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Figure 14: The previous filter could be expressed in a single line using the ‘IN’ operator as shown in this screen.

The ‘Not IN’ operator can be used in a similar way to exclude certain values from a
selection. So instead of using this filter:

Figure 15: This filter excludes the 4 Products from the selection by using the <> operator.
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Figure 16: A simpler expression can be defined using the Not IN operator shown above.

Belongs To Operator
Outline Codes have the additional operator Belongs To which makes use of the intrinsic
logic of the outline structure. 

By selecting a node in the outline code, Belongs To would select all activities belonging to
the node and any sibling node. 

Consider the following: 

An outline code has the node value ‘A’ and sibling nodes ‘A1’, ‘A2’ and ‘A3’.

The filter ‘Outline code=A1 or Outline code=A2 or Outline code=A3’ could be expressed as
‘Outline code Belongs to A’ which simplifies the filter and would have the same effect. 



Operator Means

Belongs To Selected node and siblings
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Figure 17: Example of an outline code definition.



C
om

pl
ex

 F
ilt

er
s 

- 
In

tr
od

uc
in

g 
O

pe
ra

to
rs

© 2025 Safran Software Solutions AS                                                        Page 21 | 63 

Figure 18: A collapsed view of a project without any filters applied.

Figure 19: The same Project when applying a filter using the Belongs to operator. Nodes C and B are de-
selected.

Context Sensitive Expression List for Reference Fields, Outline
Codes, and System Fields
Certain field types such as Reference, Outline and other system fields have a fixed set of
valid values which will provide you with additional capabilities when you drop into the
‘expression’ area. 

When including a Reference field, Outline Code, Calendar, Earned Value Method or
Activity Type in a filter and using the ‘=’ operator (or ‘Belongs to’, when using an Outline
code), you’ll notice the Expression drop down has enhanced properties. When you drop
into the ‘Expression’ box you will be presented with a list of valid values to include in the
condition simplifying its definition and ensuring integrity when establishing your filters. 

This functionality helps establishing filters easier and more precise.
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Figure 20: Selecting by Outline Code value.

Figure 21: Selecting by Activity type.
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Figure 22: Filter expression to show all logical succeeding path(s) from a specified activity ID.

Logic Related Filters
In addition to pure activity-based filtering, Safran provides you with a number of unique
filtering capabilities utilizing the CPM logic in your network.

Paths
Filtering on the special fields ‘Preceding Path of’ or ‘Succeeding Path of’ allows you to
utilize the CPM logic of your project in order to select and focus on or verify specific activity
sequences. 

By entering a valid Activity ID in the Expression dropdown, the ‘Succeeding Path of’ will
select all activities on the succeeding paths from the focus activity.

The picture below illustrates this concept:

The field ‘Preceding Path of’ works in basically the same way apart from the fact that it will
select all activities on the preceding paths of the selected activity. 

You can even combine the two operators in order to select a group of activities between
two logical points in your project schedule as shown below:
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Figure 23: Applying both a preceding path of and succeeding path of criteria.

Monitoring and analyzing completion of work/activities towards a completion Milestone
can often be a challenging task. Safran offers a logic-based filter allowing you to select
activities in progress where you look at activities where all predecessors are complete or
alternatively to look at activities where at least one of the predecessors has not been
reported complete.

All Predecessors Completed

Figure 24: Using the All Predecessors Completed=No criteria, finds activities where one or more predecessors
are incomplete. When all Predecessors of an activity are completed, the flag changes to yes. 
Note: The field Actual % is used when considering an activity being complete/incomplete. 
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Safran Project counts the number of predecessors and successors for each activity. This
can be used to spot high-density logic in the schedule. This may be areas that require
special attention. The number of predecessors and number of successors fields are
available for use as part of the filter capabilities.

Number of Predecessors, Number of Successors

Figure 25: Example using the Number of predecessors in the filter definition.

Figure 26: Resulting activity set highlighting activities with more than 2 predecessors to spot any high logic
density activities.
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To analyze and consider different scenarios Safran offers schedulers the ability to turn off
logic from the CPM analysis. Safran can count the number of disabled successors and
disabled predecessors. To find activities with disabled links the fields Number of disabled
predecessors/successors can be included in filter definitions. This specific filtering
capability is useful when combined with conditional formatting for the activity. This
concept is discussed later in this document in the chapter regarding conditional
formatting and filters.

Number of Disabled Predecessors, Number of Disabled
Successors

Figure 27: Finding activities where at least one predecessor is disabled.

Using Preceding Path of as a Filter for Histograms
If you use preceding path of a delivery milestone or activity that represents a minor or
major project delivery, you can create reports that show the amount of work or
manpower required to complete all activities logically linked into the milestone.

Float Paths
You can ask Safran to calculate multiple float paths through your schedule. (Select
schedule options on the Project tab). 

Together with the longest Path flag the columns Float Path and Float Path order can be
used to analyze the paths in detail. When you turn off the multiple float path calculation,
the values for Float Path and Float Path order are set to Null.
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Figure 28: Longest path, float path and float path order can be applied in filters to dive into detailed CPM
analysis.

Longest Path
Not all your critical activities are on the longest path. To find the longest path in your
schedule you can use the longest path flag field to focus on the longest path. 
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Filtering on Dates
Creating a filter on dates and date fields is vital to planners and schedulers. Putting a
spotlight on project periods, activities planned to start before or after a specific date or
comparing different date fields to focus on activities ahead of time or activities that are
slipping, is vital for planners when they want to keep control of a schedule.

The simplest filter for date fields is to create a filter that compares a field to a specific date
like selecting all activities the has a start date before 21.09.2025.

Figure 29: Simple Date field to date comparison.

Figure 30: Selecting activities that start and finish within a specific time period.

Expanding this filter, you can add a line to narrow down your spotlight by stating that you
are only interested in the activities that start after 01.07.25 and end before 21.09.25.



If your spotlight moves with time relevant to reporting periods, you may find it convenient
to use date globals to hold your start and finish dates, instead of having to update your
filter regularly.

We have come across scheduling systems that do not readily allow users to compare
date fields in their filters. In these systems filtering on dates is restricted to only being
able to compare a date field with a specific calendar date. With Safran you can create a
filter where a date field may be compared to any other date field. For example, it is easy
to compare and spotlight activities that have a Current Finish date after the Baseline
Finish date to show slippage, or where the Current Finish date is prior to the Baseline
Finish to i.e. activities that are ahead of schedule.Fi
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Figure 31: Example of filter comparing two date fields.



In addition to general activity and resource filters, Safran also provides powerful auto-
filtering capabilities that may be applied on a field-by-field basis in the Barchart Editor.
For each field in the columns area, a relevant list of values (depending upon the field
type) is presented allowing you to choose all, none, or specific activities. 

Additionally, an ‘extended’ option is also available allowing you to specify more complex
as well as multiple selection criteria. 

Auto-filters are ‘cumulative’ so that if multiple columns are filtered, all ‘filters’ are taken
into consideration and will have the same effect as using a general filter with multiple
conditions combined with the ‘And’ operator. 

Auto-filtering may also be used in combination with a general filter. If Auto-filter is
switched ‘on’ and a general filter is already in use, any Auto-filter applied will be taken
into consideration in addition to the general filter.

To invoke auto filtering, click the Auto Filter button in the Editing section of the Home tab.
The Auto-filter button is a toggle, so subsequent clicks on the button will turn the
function on/off. The Auto-filter icon will also stay highlighted to remind you that auto-
filtering is engaged.
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Figure 32: Press the Auto Filter button to apply auto filters to the columns in the Barchart Editor. Note that a
small drop-down icon is presented for all the columns.

Auto Filters

A small arrow type icon is then displayed in each column header cell designating that
Auto-filter is activated for that column. Click the arrow in the column header to display a
list of all specific values for the field allowing you to select or de-select certain or all
values for the column. If you only want to select a limited number of values, it’s a good
idea to uncheck the Select All checkbox and then check the values you would like to
select one by one. You can use the Apply button to see the effect of the filter repeatedly
until you are satisfied with the selection before closing the filter box.

The auto-filter window is extendable allowing you to see more values if needed. 
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Figure 34: Using the search box to limit available values.

Figure 33: Pressing the small icon opens the auto filter window. Select or de-select by clicking the checkboxes.

If the list of values for the column is very extensive, you can use the Search box to limit
the list to the values containing the character or characters you enter.



Keep in mind that if you apply auto-filters on multiple fields, the list of values for each
new auto-filter will be reduced as it will only show values for the activities presented at
the time. To remove all applied auto-filters press the Auto-filter button switch on the
ribbon menu again. 

The Extended filter function allows you to use more advanced criteria much like a
general filter, however the selection criteria will be limited to the selected column and
the operators relevant for the field type (i.e. Date, Text, Decimal etc.). 
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Figure 35: After applying the search (which can be viewed as filtering) the list of values is reduced.

Figure 36: Using more advanced features by applying extended filter criteria for the Auto Filter.
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If you enter and use the Extended filter function, this will overrule the simple auto-filter
function. In this case you’ll notice that the regular list of selectable values and the
‘Select All’ check box will be grayed out.

Each column with an active Auto-filter will be high-lited with it’s dropdown button and
header information in blue to ease visibility. 

Keep in mind that any Auto-filter setup or configuration you use will not be saved as
part of your layout when you switch layouts or close the Project. 
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Figure 37: Editor Histogram View options. If you select the 'Selected Activities' option, the histogram and s-
curve will apply the activities selected and highlighted in the Barchart Editor as a filter.

There are a few operations where you can apply a filter based on the activities you have
highlighted in the Barchart Editor such as Assign Fields, Assign Link Fields, and Partial
Baseline. In addition to highlighting a group of contiguous activities, you can also select
numerous non-contiguous activities by holding the CTRL button down while highlighting
specific activities. The selected row may also be used together with the Editor Histogram
if you check the view option Selected activities. 

Selected Rows - Pre-Selecting Activities for Certain
Operations

Figure 38: Please note the "selected rows" check box in the lower left corner. This is active if you select a
range of activities prior to opening the Assign Fields Option. To the right the number of activities to be
updated is displayed together with the total number of activities in the schedule.
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Figure 39: Selecting activities with specific resource types assigned. The above example shows activities with
Resource Name Containing Hours.

In the resources field, Safran lists the resource codes assigned to the activity. The codes
are separated by a comma. You can apply a filter to narrow down on activities with one
or several resources assigned.

Resource Filtering

In addition to selecting activities with specific resources assigned, Safran also allows
you to include only specific resources in your reports . This may be advantageous if you
would like to focus on a specific resource or group of resources when working with
resource based Histograms in the Barchart editor or the Histogram & S-curve report.

If you want a report to include only certain resources, use the Drag ‘n’ Drop technique to
select the relevant resources for your report and drag them to the right to the Selection
panel. The report will then be based on the resource categories selected. Note that
default is includes all resources. That is: no selection=all resources.
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Figure 40: The Resources tab is split into two panels called ‘Available’ and ‘selection’. Note that all resources
are included as default.

You can find the Resource filter on the right-most tab of the Properties window in the
following tools and reports:

Barchart Editor - Histogram
Histogram & S-curve
Performance Chart
Bull’s Eye Chart
Progress Summary

The Resource filter in the Barchart Editor Histogram is established in much the same
way as an activity filter however it can only filter on resource codes. A new filter row will,
by default, be ‘Resources =’ and the Expression dropdown will present a list of
Resources. Resource filters can make use of a comprehensive set of operators such as
‘=, >, <, Begins, Ends, Contains, and IN’ and also contain multiple rows or expressions
separated by OR/AND. This may be useful if you have a varied and complex set of
reource definitions.
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Figure 41: Filtering for specific resource type in the Editor Histogram.

Keep in mind that, in both cases, the resource filter will be considered in addition to any
activity filter applied in the Editor Histogram or report. 
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Figure 42: The filter drop-down list can get long, especially with many users and a project database with
many different projects.

When working with Safran in larger organizations and on larger projects with many
users, the amount of defined filters often grows quite large. Organizing and finding the
filter you need  can be a  challenge. 

By default, all stored filters are identified by the User who created the filter. You’ll notice
that the ‘Users’ dropdown is by default set to ‘User’ so that when you drop into the
‘Name’ dropdown you will see a list of your own filters only. 

Working with Large Amounts of Filters - Creating Order
from Chaos

If you change the ‘Users’ dropdown to All Users, the list of filter names will include filters
from all the users in the database. You will also notice that all filters are qualified by the
User Name that created and owns the filter. 

Figure 44: Selecting Project Users in the 'Users' field will show only filters that are created by users with access
to the project.

The final ‘normal’ option here is to select ‘Project Users’ which will limit the list of filters to
filters from users that have at least Read access to the project you are currently working
with.

Figure 43: A first step in narrowing down the list can be to select something else than All Users.
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Limiting Filter Lists
Another way to simplify finding filters is to use the ‘Limit List’ function which you will find
to the right of the Name dropdown of the Filters area of the main Barchart Editor menu.

Figure 45: The 'Limit List' is a function to apply a filter on the filter names displayed in the 'Name' dropdown.

When you press the Limit List icon a new panel opens allowing you to limit your list of
filters based on any combination of the Filter Name and the Filter Owner. In both cases
a comprehensive list of relevant operators are available with =, ><, Begins, Contains etc.  

Figure 46: You can select the filters from Owner and filter Name.

When you press the OK button to return to the tool you are using and then drop into the
Name dropdown, you’ll see that the list of filters only contain the filters that fulfill the
filter criteria. 

Figure 47: The drop-down list is focused showing filters with the name containing Large and created by the
SAFRANSA user.
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Keep in mind that once a Limit Filter List is applied it will be valid for all activity based
filtering lists throughout Safran, ie. the Barchart Editor, the Reports Suite, Assign Fields,
etc.
 
In all areas of Safran when you open a filter definition panel you’ll also be able to
access the Limit List function by pressing the small square icon with two small dots
seen to the right of the filter dropdown.

Figure 48: The Filter limit list can be accessed by pressing the icon next to the name drop down.

Further, to keep you aware that a Filter Limit List is applied, you’ll see that the Filter Limit
List icon on the Ribbon of the Barchart editor is highlighted in light green as shown
below. 

Figure 49: If a limit List expression is applied, the Limit List function gets a green background.

Limiting Layout List
Please note that the functionality to limit the number of filters displayed to a user is
similar to that available  for Layouts, User drop down, Report groups, and limit list filter
functions.
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Filter Groups
To further assist grouping of filters and ease locating filters, so-called Filter Groups
may be established.

The facility to establish and maintain filter groups is located to the right of the Admin
Tab of the ribbon in the Report Maintenance group. 

Press the Filter Groups icon to open the Filter Groups window.

Figure 50: Figure 1 The Filter group option is located on the Admin tab. It allows you to collect the different
filters into groups for ease of use and system maintenance.

Figure 51: Groups are listed in a tree-view. Add a new group by pressing New, edit the name and drag the
filters across. Using this feature, you can build groups of filters for specific purposes and use cases.

When the Filter Groups panel opens, you can create a new filter group by pressing the
New button. 

A new filter group with a default name ‘New_n’’ will then be created. The name can of
course be edited.



To the right of the window you will see a list of all available filters in the database,
grouped by the users who created them. Each User may be collapsed and expanded
to ease searching for filters. 

To add a filter to your group, use the drag ‘n’ drop technique and drag the filter to the
middle portion of the window. You can add as many filters to the group as needed. 
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Figure 52: Click and drag the selected filter across from right to left to include it in a group.

Figure 53: Selection of multiple filters for inclusion in filter group.



Multiple filters may be selected by holding the CTRL key and selecting filters. The filters
selected will be highlighted by a ‘check’ mark. When you have selected your filters
then drag the filters to the center portion of the panel.

Remember to give the filter group a name by setting focus on the name and then
clicking again. You’ll then see an ‘Edit’ box allowing you to enter and change the filter
group’s name.
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Figure 54: Filter groups shown to the left show group names and filters included. The filters are shown with
name and owner.

Finally press the Save button to save the filter group and then press Close to close the
window and return to Safran.
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Figure 55: If you highlight the group name, the filters included in the group are displayed in the center
section.

Figure 56: The highlighted filter shows the expression in the center part of the window.

Examining and Modifying a Filter Group
Once you have established one or more filter groups you’ll notice that when you set
focus on a filter group name, a list of the filters in the group are presented.

If you click the + sign to the left of the group name, all the filters contained in the
group will be listed.

If you then set focus on one of the filters, the filter definition is shown in the center
portion of the filter group panel.

For ease of use the Filter Groups panel is scalable. Additionally, the three portions of
the Filter Groups may also be re-sized.



W
or

ki
ng

 w
ith

 La
rg

e 
Am

ou
nt

 o
f F

ilt
er

s 
- 

C
re

at
in

g 
O

rd
er

 fr
om

 C
ha

os

© 2025 Safran Software Solutions AS                                                        Page 45 | 63

Figure 57: The Filter Groups window is resizable.

Figure 58: Simply highlight a filter name and drag it from left to the right to remove it from a filter group.

To remove a filter from a filter group, first locate the group and expand the list of filters. 
Then, set focus on the filter you want to remove and using the ‘Drag n Drop’ technique,
move it to the right-most, “Available Filters” part of the window. 

Remember to press Save to save your changes. If you do forget this, Safran will still
remind you and encourage you to save the changes.

Removing a Filter from a Filter Group
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Figure 59: The Users dropdown on the Filters sub-section showing existing Filter Groups.

If filter groups exist, you’ll notice that, when the ‘Users’ dropdown for Filters is selected,
any filter groups defined will also be included in the list. 

If you then select a filter group, the list of filters in the Name dropdown will be reduced
to include only the filters from the selected filter group.

Using Filter Groups
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User Filter
A so-called ‘User Filter’ is available in Safran. This filter has ‘universal’ or ‘default-like’
capabilities as it is taken into consideration even when you haven’t specified or
selected a filter for a certain tool (ie. Barchart Editor, Report or Assign Fields etc.).

This filtering function may be useful if you are working with a very large project and
when you normally only want to work with a certain portion of the project and still
want to filter on specific activities. 

You can find the User Filter function on the Home tab of the ribbon to the right in the
Editing area.

Figure 60: Select the 'User Filter' option on the Home tab.

When you press the User Filter icon, the User filter window opens allowing you to select
a filter.

Figure 61: User Filter window. Like the standard filter window in layout and function.

When a User filter is activated, you’ll notice that the User Filter icon on the ribbon is
highlighted.
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Figure 62: When active the User Filter option gets a green background color.

Keep in mind that the User filter will be active for your current Safran session until you
modify or turn it off/remove the filter conditions.

When you leave your Safran session it will be removed. 
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Activity Search List
The Safran Activity Search List is a highly unique type of filtering capability that allows
you to scroll through a list of activities, find a specific one and jump to it. 

This is very useful when working with very large schedules in cases where you work
with a specific type of activity within a larger group. When you open the activity
search list tool, the list will consist of all activities in your project, however you may
apply a standard Safran filter to limit the list to the type or group of activities you
intend to work with.

The Activity Search List is found under Options in the Filters area of the Home ribbon.

Figure 63: Press the Options icon to open a drop down and select the Activity Search list.

Figure 64: The ‘Activity Search List’ provides a list of activities that fit the criteria. You can use this to navigate
up and down the list. Note that the ‘Activity Search List’ does not filter on the Activities in the Barchart.

When the Activity Search List panel opens, all activities are presented with their Activity
ID and Description sorted by Activity ID. When you highlight an activity in the search
list, you’ll notice that Safran will jump to and set focus on that activity in the Barchart
Editor. 
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If the activity is in a collapsed section of the Barchart Editor, Safran will open the
section and set focus on the activity. 

If a filter is applied in the Barchart Editor and the activity you try to select is not a part
of the selection, you will be warned of this as shown below.

Figure 65: A warning is shown if the Activity is hidden or filtered.

Figure 66: ´Activity Search List’ and the Filter window displayed.
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To limit the number of activities on the list, press the filter button at the bottom right
corner of the Activity Search List panel. When the filter panel opens, you can select an
existing filter or enter an ad-hoc filter. Pressing the ‘Previous On List’ or ‘Next On List’
buttons allows you to jump up or down one activity at a time on the search list. The
Activity Search List panel will stay open until you decide to close it. This allows you to
work with your activities or resources and still use the search list as a navigation aid.
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Figure 67: The font window with the filter window open. Use this to create conditional row formatting in the
Barchart Editor.

Conditional Formatting
Conditional formatting allows you to highlight information in a number of different
ways:

Set the color to red for an entire row to draw attention to an activity if a certain
condition is met. 
Change the color of an entire column to draw attention to the field in display. 
Set cell colors of a column to a specific color when conditions are met. 

All this helps in focusing on vital details and increasing visibility assisting reading
report information. Conditional coloring can also be used to build traffic light type
reporting. Good, ok, bad, really bad etc.

Row Coloring
Heading, table row and group coloring is defined individually. The table row formatting
applies to all table rows and columns. However, you can define exceptions in order to
highlight information. 

Conditional formatting for rows may be defined using the fonts feature. Add a row to
the conditional formatting, name it, select attributes and press the filter button to add
the condition or select a predefined filter from the Filter drop down.
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Figure 68: The Early start column is highlighted with a Goldenrod color. This helps draw attention to the
information in this column.

Column Coloring
Formatting an entire column to draw the attention of readers is easier. Select the
column properties, then select the text color and column background color.

Conditional Colors - Formatting a Cell
Pressing the ‘More>>’/'<<Less' button (the button toggles between More and Less) on
the Column Properties panel expands and collapses the panel and allows you to
define differing text color and background colors for column cells depending on
column values. Press the 'Add' or 'Insert' button to add a new Conditional Color and
then press the 'Filter' icon to add a relevant filter. 

In the example below ‘traffic light‘ formatting is used to highlight the Actual % value for
activities that are ahead or behind schedule by adding a filter for each 'case'. Actual %
for activities on schedule would in this example be presented in the Text Color and
Background Color chosen for the general Column properties.
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Figure 69: Conditional colors may be controlled by a filter.

Add a filter to each conditional Color:

Figure 70: Filter expression for the Behind schedule category.

The filter and settings above will give you this result.
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Figure 71: Actual progress in green if ahead of schedule, actual progress in red if behind schedule.

Keep in mind that the properties discussed above will also apply to any
aggregated/group level value. In some cases, this might not be desired, so to ensure
that the conditional colors are only applied to the activity level you would need to add
an additional argument to your filter such as 'Activity Type <> Summary' or 'Activity
Type=Activity' as shown below.

Figure 72: Adding Activity Type<> Summary is used to apply the conditional formatting to the activity level
only.
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By default, when a new symbol is defined it will be drawn for all activities. However,
many of the symbols used in a Barchart or Gannt are often “conditional”. Draw bar in
green if discipline is engineering. Draw bar in red if activities have negative float, are
just two examples of how you can create bars to highlight and add information to the
bars. This is done by using the filter capabilities of the symbol definition.

Symbols are drawn for activities but can also be shown at summary levels by
checking the appropriate boxes In the Group tab.

Figure 73: The symbols window. The ’Drawn’ on field allows you to set the symbol to be conditional (filtered)
and apply a filter.

Using Filters with Symbols
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Figure 74: All incomplete activities where Task Code=00PK – Product Kick-off will be drawn with the
‘Product Kick-off’ symbol.

While the ‘Visible’ tick box on the Symbols tab of the Symbols window controls whether
or not a symbol is to be presented at the activity level, the ‘Visible’ tick box on the
Groups sub-tab of the Symbols tab controls which grouping field or level a symbol is
to be presented for. Although you can use a symbol at both activity and group level,
most often these would be different symbols. To ensure that a group level symbol is
not presented at the activity level, please remember to switch off ‘Visible’ for the
activity level.

Finally, a summary bar/group level symbol may also have a filter providing the ability
to present differing symbol characteristics for differing code values for a group.



C
on

di
tio

na
l F

or
m

at
tin

g

© 2025 Safran Software Solutions AS                                                        Page 58 | 63

Figure 75: Check visible flag on/off to control visibility of summary bars.

As with the list of Filters itself or other library functions, the number of items can grow
as time passes. The filter window provides you therefore with two filtering options.

One is the ability to reduce the list of symbols to show only those symbols that are
visible in the current layout. This will also include symbols shown on summary levels.
Include visible symbols only shows only symbols that are currently checked as visible
plus the ones used on summaries.

In addition, by pressing the filter button, you may select a range of symbols based on
Symbol Name, Start/Finish date field or Drawn on properties as shown below.

Filtering within the Symbols Window
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Figure 76: The filter function within the symbols window lets you filter on symbol attributes. Applying the filter
the symbols list window shows only the filters that fits the selection criteria.
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The Count Activities function enables schedulers and planners to ‘automatically’
summarize the number of activities both per period and cumulative. 

The Editor Histogram contains a Date field called Count Activities. For each activity the
value is one. 

The count is related to a date field and can be used as a basis for histograms and S-
curves. Using this feature, allows you to show the number of activities planned to
complete each period vs. number of actually completed. 

The Data field ‘Count Activities’ can also be expressed with a filter. Meaning: count the
number of activities with this specific condition.

Counting Activities in the Editor Histogram

Figure 77: An example of counting the number of activities with a condition (i.e. Filter).



Se
le

ct
in

g 
th

e 
D

at
a 

to
 E

xp
or

t -
 P

ro
je

ct
 E

xp
or

t

© 2025 Safran Software Solutions AS                                                        Page 61 | 63

Selecting the Data to Export - Project Export
When exporting project data to a file format, the Default is to export all activities for
the project.

You can however also apply a filter to select certain activities or part of your schedule.
Additionally, you can also include or omit certain information elements such as Links,
Resources and their Availability, as well as Baselines, Status information and Schedule
risk data from the export. You’ll find these options in the data pane of the Project
Export window.

Figure 78: By applying a filter you can export parts of your project schedule to a file. The above filter exports
activities and associated info for all activities where Product = HP00A - HPU.
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Importing and Exporting Filters
Filters are global within your Safran database. To enable exchange of filters between
databases Filter Export and Filter Import options can be found on the Interface section
of the File tab. The export window allows you to select filters to be included. An
identical option is available for import. 

Figure 79: Use the include checkbox to select the filters to be included.

Note that you are only allowed to export the filters you have created yourself.
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Summary
Filters are widely used and are of paramount importance when you want to put a
spotlight or laser focus on certain aspects of your project schedule. By using filters, the
navigation and the search for deviations and issues is far more effective and efficient. 

Using filters to create conditional formatting and symbol definition helps in
highlighting important information and readability.

Finally, we hope we have shown that, by using filters and grouping capabilities to
narrow down the number of filters and layouts increases both ease of use, navigation
and productivity.

Thank you for reading this ‘Spotlight on the use of filters in Safran’ guide.


